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Microsoft Excel-2007

Excel: = Ms-Excel is a WINDOWS based automated spreadsheet or worksheet

manager. It provides different tools for generating related information in effective-

representable form.

What is Spreadsheet or worksheet=2 Spreadsheet or worksheet is nothing but a table or

matrix of several rows and columns, which 1s made by group of cells.

Whatis Cell =—> Intersection of each row and column is termed as cell.

Workbook = Excel organises worksheet by workbook .A new workbook contain 3

worksheets by default (can be changeable),but we can add more and Remove also.
s—> Fach worksheet contain 1,048,576 rows (Numbered as 1 to 1,048,576 ) and 16384
columns(named as A to XFD).
How to Starting Excel:-
Start — Programs —— Ms-Office—— Microsoft Excel .
OR
Start » Run » type the “ excel” — ok
Then you can see the general interfacing screen of Ms-Excel.
Active cell
I /Title bar Menu bar
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sz;y Calibri Sl AN E'W/". S5 Wrap Text General M :E;g ‘_Fif r;'dL jl:\:! j’\ ’DJ E:;Tfsum' %? ﬁ
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Important parts of Excel:-

1) The reference area displays the address of the active cell.

2) The formula bar 1s where we can enter or edit data & formula.

) Cells are where we can enter data & formula.

) Row numbers and column names let us quickly select a row or a column.

) Worksheet tab let us quickly move between two worksheets or rename them.

) Active cell 1s the cell we currently select or where we are currently entering data.

3
4
5
6

Sum Formula :-(+)

= | | =

!

=SUM(A1+A2+A3) «

Auto Sum Formula —>
=SUM(A1:A3)<
OR

Click the Auto sum button on the toolbar.

Subtract Formula =— (-)

MS-Excel 2007 Page 2
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Multiply Formula = (*)

~(A1*A9)

Division Formula = (/)

~(A1/A9)

Percentage Formula —> (%)

!

~(A1*A%9%) <

MS-Excel 2007 Page 3
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Formula of Maximum:-

“MAX(A1:A3) «

Formula of Mimmum:-

“MIN(A1:A8) <«

Formula of Average:-

S| O | | N~
x©
(=)

!

_AVERAGE(A1:A5) <

MS-Excel 2007
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Formula of Count-

“COUNT(A1:A8)<]

Formula of Countif-

=COUNTIFAL:A5,”ANY TYPE OF COUNT NAML”) <J

~COUNTIF(A1:A5,”2ND*) .

Exercise —>
4 ' A B C D | E | F |
1 Product Name | Quantity | Price
2 Book 3 52
3 Pen 2 15
4 Ink 1 35
5 Ex. Book 30 25
6 Sub Total
7 Sales Tax 6%
8 Total

Sub Total =(B2*C)+(B3*C3)+(B4*C4)+(B5*C5) <+
Sale Tax =(C6*6%) <
Total =(C7+C8) <
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P H9--% | Bookl - Microsoft Excel Chart
How to create the Chart & —
O tO C ea e y Home Insert Page Layout Formulas Data Review View Desir
. == =
Wizard P i N R = S T
Change Save As Switch Select == ||= —_—=
Chart Type Template || Row/Column Data T
. Type Data Chart Layouts
1. At first make the project. | p— C ]
2. After that select the all project & go to A B_| ¢ b_| E F £
1 Name Course | Roll No |Semester
the Insert menu on the menu bar. 2 [Sumit Roy ADCA | 123586 L
3 Sumita Ghosh DOAP 125693 2
3. Then you select the chart type. 4 Munirulislam ___[DCA 125693 1
. . 5 |Inteaj Alam DOAP 125782 1
(You can see the chart wizard in the 6
7
worksheet) 8 126000 <
3 125500
10 125000 |
1 124500 |
12 124000
13| | 123500 B Semester |
12| i 123000
15 122500 1
16 122000 =
17 ADCA DOAP DCA DOAP
18
19 Sumit Roy Sumita Munirul | Inteaj Alam
20 Ghosh Islam
ral
Bookl - Microsoft Excel
|
Text Ahignment =—> 1 B g
£ » || %8 59| Conditional Format C
= = Formatting ~ as Table ~ Sty
1. At first select the text. = dif - = Sty
Wrap Text L
2. Then go to the Home menu on the menu bar. £ _ Make all content visible within
1 Microsoft E: c_eII by displaying it on multiple
3. Then click Warp text option. 2 l, e
Microsoft
1 Excel
2
__ |{@ PressF1 for more help.
!'/E-Eg:‘;\ HY9-6-Z |5 Bookl - Microsoft Excel
y Home Insert Page Layout Formulas Data Review View

Marge & Center ::> _3 :‘; Calibri MEER sl

Paste g B2 U -~||[E-|&- A

|3 General
| £ I$'°f=9ll".'u'3-i"fglr
F} Alignment El Mumber F}

1. At first select the two or thee Sihoae= co
| A2 - I | SCSM Harirampur * D/Dinj Merge & Center
CCH. o B C 2] E F Joins the sel
Excel larger cell an
2. Then go to the Home menu on [ ScoM Rarirampur ~ D/Dinajper 1 11 7] P
This is often
- that
the menu bar. .y 2t span mt
il 2

3. Then click Marge & Center option

(@ Press F1 for more help.

GO~ W W N
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¢ Numbers Format in Active Cell
1. Atfirst type the number above

11 number in the Active Cell.

o

Then select the Active Cell
Then go to the Home menu &

Numbers Format on the menu

bar.

4. At Last Choose the Number

option.

Insert the Logo or Picture :

1. Click the Insert Button

on Menu Bar

2. Then Click the Picture

Option & Choose the
any logo or Picture

D“a\ = 9~ x s Bookl - Microsoft Excel
iy
Home Insert Page Layout Formulas Data Review View
=] £ Caiibr fjun CA || =R (& | [ }E|
£ S
Paste -[@E [~ A-||[= = =|[:E=||=- || aABC Sener =
- f (B A T | Eﬂ & CuliliES=ElemEs] ;‘E 123 Mo specific format
Clipboard & Font {F] Alignment
- - g /:/ Number ™
| c2 - f« | 4354100003507 (| 12 sssmo000350700 |
A B c Currency
1 | SINo Name Account No Bank @, $4,354,100,003,507.00
2 1|{Rahul Harijan 4354100003507 Bank of Ind -
@ Accounting
3 2|Sumit Sarkar 303550002351 |State Bank !-_':'_-JJ 4,354,100,003,507.00
4 3|Madhumita Das 304215100002310|United Ban|
Short Date
3 4 T ssssssssss i |
6 5 1
=% -
Home Insert Page Layout Formulas Data Review View

ol o

VDD gl D e 1)

« Short & Filter :

e Select the Data Cell & Click the DATA

Menu.

180 #0061  3H08
CERTIFIED ORG

sINol

e 'Then Click the A to Z or Z to A option.

And Shorting Your Data.

&

e Then Click the Filter option.
e Then Filter your Data.

PivotTable Table Jlip Shapes Smartart || Column Line Pie Ear Area Scatter Other
Art - - - - - - - Charts ~
Tables Nlustrations Charts Is
D20 Insert Picture from File
A Insert a picture from a file, | D E
@ | (ig) Press F1 for more help. scsm

1 E - mpur

2 _ Harirampur, Dakshin Dinajpur, Email : indiascsm@gmail.com
ASEEEEE

3| s5.c.5.M Ministry of HRD Govt. of India

a

5

Name | Account No | Bank Name | Departme
{ome Insert Page Layout Formulas Drata
\ccess 5 o ﬂ |&3] Connections
Veb —IJ —IJ L= Properties
From Other Existing Refresh N |
ext Sources ™ | Connections Gfje e AL LIS C
Get External Data Connections
B5 - 5 | Name SortAto 7
B C Sort the selection so that the
- lowest values are at the top of the
"allralllllllﬂ —
. . . . (@) Press F1 for more help.
E Harirampur, Dakshin Dinajpur, Ema < -
Fe . .
8.M Ministry of HRD Govt. of India
W00 2008
WIED ORG
Name A Account No - Bank Name > | Departme
.|Rahul Harijan 4354100003507 |Bank of India Teacher
!|Sumit Sarkar 303550002351 |State Bank of India Admintrati
{|Madhumita Das 304215100002310|United Bank of India Teacher

MS-Excel 2007
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Data Validation :

[ J
e C(lick the Data Menu & Click the Data Validation Option.

e Then Choose Whole Number & Type the Minimum Figer & Maximum Figer
e At last click the ok button.

Iy E!E'-l , Hd9-o-z )+ Bookl - Microsoft Excel - o X
- Home Insert Page Layout Formulas Data Review View @ -2 X
gy From Access =y oy = 5] connections Al T " Clear E_‘E =4 Data validation ~ ¢ ¢'Zr #Z
g From Web S II@ 1 Properties ‘ \"\;0 Reapply —  [F& Consolidate L L =3
. Fraom Other Existing Refresh o Zl Sort Filter Text to Remove X Group Ungroup Subtotal
,_;j From Text Sources* | Connections All~ == Edit Links B __\_",:)Ad\ranced Columns Duplicates (EP What-If Analysis ~ - -

Get External Data Connections Sort & Filter Drata Tools Outline la
Data Validation Data Validation
Settings | Input Message | Error Alert | Settings | Input Message | Error Alert |
Validation ariteria Validation ariteria
Allow: Allgus
u.ﬂ Ignore blank n Y| Ignore blank

Data:

Any value
Whole number

50

[] Apply these changes to all other cells with the same settings pplyf these changes to all other cells with the same settings

o) (o o) (e

Hd9-¢- =z 7

Home Insert Page Layout

. Page Break Preview :

e Click the View Menu, | = |8 |
e Then Choose & click the Page Break 12| Custom Views V€

. . Mormal Page
Preview option. Layout = Full Screen | I

| Workbook Views

D15 Page Break Preview

i £ E View a preview of where pag
5 break when this document is
5 printed.

4 -

b

E

T

S

&

10l
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Office of the

Joyhat Gram Panchayat

Scheme wise Expenditure of MGNREGS Fund Report for the year 2013-2014

Skill
Sl. Wage | Materials | Semi Total
No Name of scheme Sceme code no. Cost cost skilled Cost
cost
Earthen road from Rajnagar Utpal Balo
1 | house to Nimai Mandal house 67542 4591 72133
Re-exavetion of Fakirakur Pond at
2 | Baidara 39702 39702
Earthen road from Pradip Barman house
3 | to Tarani Barman house 79123 6283 85406
Re-exavation of Katabari Bhut Pond at
4 | Jatnarattampur 60761 2319 63080
Earthe road from Kajaldighi to Bhuban
5 | Balo house 73418 6872 80290
Earthen road from Rajnagar Bhobesh
6 | Biswas house to 31662 31662
7 | Earth filling at Maghiapara Football Field 23065 1714 24779
Earthen road with RBM Chowlihar pond
8 | to Jagdal more 9934 9934
9 | Construction of Senitation 149490 455445 604935
Earthen road with RBM from Nijamuddin
10 | house to Manirul house 8154 8154
Earthen road from RBM Romesh Kutti
11 | house to Dijen Roy house 15733 15733
17 | Earthen road from Battala to Banshbari 61602 61602
18 | Contingency 3200 3200
Total 620186 458645 | 21779 | 1100610
Prodhan
Joyhat Gram Panchayat

MS-Excel 2007
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Home Insert Page Layout Formulas Data Review View Add-Ins
_3 '*' Cut Calibri -l -lAA| == =¢ Wrap Text General -
Paste a1 copy B U-|[B-[dA-E=EE= =] M = - g <0 .00
= # Format Painter = L] === EMEACERtEE=S| || M)  * |[%0 sl
Clipboard ] Font P} Alignment P} Mumber IF]
| G13 - [ fe | =G12
A B C D E F G H |
A
2 SLNO DATE PARTICULAR | CHAQUE NO | DEPOSITE | WITHDRAW BALANCE
3 1 1/1/2016(A/c Opening 500 500 =E3
4 2 5/1/2016(By Cash 100 400 =G3-FA+E4
5 3 400
6 L 400
7 5 400
8 6 400
5 7 400
10 8 400
11 9 400
12 10 400
13 Total= 400 =GE12
14
15

Bookl - Microsoft Exc

Home Insert Page Layout Formulas Data Review View Add-Ins
_3 * Cut Calibri 1 A A= = Wrap Text General -
S Copy
Pajte # Format Painter (B I U-|H-[|&-A-|E = =ad Merge & Center ~ ||| § ~ % o || %0 3%
Clipboard F] Font F] Alignment F] Mumber Ul
I H9 - (. |
A B C D E F G H | ]

1 CRICKET SCORE
2 NAME 1STOVER | 2ND OVER | 3RD OVER |4TH OVER
3 JAHIRKHAN 25 28 29 7
4 MR.KARTIK 12 16 6 9
5 | IRFAN PATHAN 8 12 9 19
6 | ANIL KUMLAY 20 12 28 5
7 | AJIT AGARKAR 10 6 6 10
2 | S.TENDULKAR 6 5 22 12

3 | HARVHAJAN 9 71 l |
10
11 35
12 30
13 25
14 20 W Seriesl
15 W 5eries2
= W Series3
17
18 M Seriesd
19 W Series5
20 M Seriesb
21
22
23
24

MS-Excel 2007 Page 10
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. Home Insert Page Layout Formulas Data Review View Add-Ins Design Layout Faorn

b
4

b af, | x =l | e e
Change Save As Switch Select Ed @ = """'u—_,' "'—--_____d. e .

Chart Type Template || Row/Column Data

Type Data Chart Layouts
| Chart 10 - fe |
A B c D E F G H I ] K

1 STUDENT INSTALMENT CHAT WISE
2 MNAME DATE FEB MAR | APR | MAY | JUN | JUL | AUG |Total Payment
3 BIDUT KUMAR SARKAR |13/4/2003 200 200 200 300 900
4 RAFIZHOSS5AIN 14/4/03 0 200 100 150 0] 250 210 910
5 SOMNALI KHATUM 15/4/03 100 200 o0 100 100 0 250 750
6 RAJU AHAMED 15/4/03 150 1] 200 0 150 200 200 900
7 TANUIA SABNAM 20/4/03 200 100 0 200 100| 150 100 850
& RAJAB SARKAR 20/4/03 300 1] 150 200 100| 150 200 1100
9 BASUDEV MAHATO 20/4/03 250 100 150 200 100| 150 1] 950
10 MABIN GUPTA 27/12/02 150 200 200 o0 300| 150 200 1200
1| TOTAL = 7560
- = =
13 -

- TOTAL=
4 20000

p NABIN GUPTA
15 15000 -
16 ) BASUDEV MAHATO

10000

17 RAJABSARKAR
18 3000 1 TANUIA SABNAM

——
13 0 I B RAIU AHAMED
20
0 Qg\“' & & & IS N & -x‘&& = SONALIKHATUN

a® m RAFIZ HOSSAIN

22 a8
23 < M BIDUT KUMAR SARKAR
24 .}
4 4 » M| Sheetl ~Sheet2 -~ Sheet3 ~¥1

Ready
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1 J:‘;\"' = =~ = = PAY BILL FOR JAMUARY 2015 [Compatibility Mode] - Microsoft Excel = = x
i3
Home Insert Page Layout Farmulas Data Review WView e - T X
19 - fe | =SUM(ES:H9) ¥
A B C D E F = H | J K L MM O B ] R 35 T W
1 [See Rule 15]
2 BILL FOR GOVERNMENT GRANT ON ACCOUNT SALARY OF THE EMPLOYEES Durgapur Gram Panchayat.
3 BILL FOR THE MOMNTH OF JANURARY 2015.
4 | Total Amount of the bill Rs. 124429/- (Rs. One lac Twenty four thousand Four hundred Twenty Nine only. )
5 Deduction Ded Net
Ad .
Total van Net ucti [ amount
= Name of Gram Basic | Grad - Grant H. Payable | on to be
Mo. | Panchayat Staff | Pay Pay BF?IC D-A. |H.RA.| M.A. Total | % |P.T.| P.F. |R. I.T| Total from of | paid to Account No. |Bank nams.
ay if ax .
A Treasury |[GSL | incumb
any
5 | ent
e 1 OSM[‘;Nﬁ;;ON' 16990 | 3600 | 20590 (11942 | 3089 | 300 | 35921 | 0 |160| 6000 | 0 [ O | 6150 29771 40 | 29731 | 31884968940 Itsahi'r'
2 Birendranath | 44450 | 5900 | 14320 | 8306 | 2148 | 300 | 25074 | 0 |150| 2000 | 0 | 0 | 2150 | 22924 | 20 | 22904 |10%000335261| RCECB =
8 Debsharma (Secy_) Kaliyaganj.
3 Amar Roy 12110 4400 [ 16510 | 9576 | 2477 :/‘?J 28863 0 |150) 3000 | O 0| 3150 25713 a0 25633 | 20037091486 S'E!'I
9 M.S) Karnajora.
4 Tuhin Das 7770 | 2300 | 10070 | 5841 | 1511 | 300 | 17722 | o |130| 1000 | 0 | 0| 1130 | 418592 | 20 | 16572 | 31856267880 | . ° B!
10 (Sahayak) Karnajora.
5 Reska Hasda | 544 | 1000 | 10540 | 6113 | 1581 | 300 | 18534 | 0 |430| 2500 | 0 | 0 | 2630 | 45904 | 10 | 15804 | 31856267891 | > B!
11 (P K} Karnajora.
g | Hanu Ch Barman | cpon | 4700 | 8390 | 4866 | 1259 | 300 | 14815 | o |110| 1000 | 0 |0 | 1110 | 13705 | 10 | 13695 | 31853684104 | 5B
12 (P_K_ ) Karnajora.
11 Total- 63620 | 16300 | 80420 (46644 [ 12065 | 1800 |140929 | O | 820 (15500 ( O | O (16320 | 124609 180 | 124429
14 (Rs. One lac Twenty four thousand Four hundred Twenty Nine only. )
Certified that the Gram Panchayat Employment whose names are included in that bill is likely to been employment for the entire of month of
JANUARY 2015 of the year and that no bill for the above mentioned incumbents (s) has been drawn before.
15
16
17 Signature of Custodian
18 Cheched and found correct the bill may be
M4 4 » M| Sheetl -~ Sheet2 ¥ [ ! I |
Ready U@ =] 100% @ L) _@_

& = L [ cp £ | fiw] ” (! o m 3:06 PM E
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cel Marksheets Microsoft Bxc

Home Insert Page Layout Formulas Data Review View Add-Ins @ - o x
_3 :Z E:Ly Calibri -l A= = Wrap Text General - ijg' % _;ZI E‘I = LE__\ é ’::ltfsum ” ? [ﬁ
e ot B2 5] 0 )[R e o [0 [ )| ot ot G| o ot S0 s pru
Clipboard (] Font (] Alignment (] Mumber L] Styles Cells Editing
| H17 - (> S| ¥
A B C D E F G H | i K L M N 8] P Q R 5 T u ol
1 MARKSHEET
2 SLNO MNAME ROLLNO | BENG-A | BENG-B | ENG | MATH |LIFE. SC.| PH.SC. | HIST | GEO |TOTAL |DIVISION | % OF MARK
3 1|ANANDA SARKAR 1 40 45 42 50 60 353 30 40 342|3RD 42,75
a4 2|RAIU KUMAR 5 30 35 35 40 40 50 45 50 325(3RD 40.625
3 3|BABY MAHATO 10 30 40 60 30 45 44 35 60 384|2ND a3
6 A|AMRITA SARKAR 15 40 50 60 40 50 35 30 30 335|3RD 41.875
7 3|SUMAN ROY 20 45 30 30 45 45 30 30 60 335|3RD 44,375
8 6|NIRUPAM SEN 30 30 30 50 40 50 60 a0 40 350|3RD 43.75
9 7|ANKITA DAS 25 30 35 36 50 50 60 54 52 367|2ND 45.875
10 8|GOURAMNGA DAS 30 30 40 30 60 30 40 30 33 335|3RD 41.875
11 SISUSMITA DUTTA 35 30 35 36 38 39 70 40 60 348|3RD 43.5 A
12 10|5SUMAMN PRAMAMIK 17 36 a7 38 39 42 41 42 50 335|3RD 41.875 1
=
14 Division Formula > =IF(L3>580,"STAR", IF(L3480,"15T",IF(L3>360,"2ND",IF(L3>275,"3RD", "FAIL"})))
15 % of Mark, Formula == =13/8
16
17 I .I
13
19
20
21
22
23
24
25
M 4 » M| Sheetl - Sheet? - Sheet3 %] [ i

Ready R 00%
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Detalls of Student Tutuin fee Instalment £ Microsoft Bxce

Home Insert Page Layout Formulas Data Review View Add-Ins @ - =7 X
& cut Calibri 1 A ||| ==|®| |SWapTet General - iﬁ‘ ﬁ:bl 7 Cm ’E—_\ E Autosum - % lﬁ
23 Copy - ﬂ » 3 = ; [#] Fill - .
y— [0 A (8 3 ceneconer 80 [0 80) Gotonst fomt 1 e ot ot S0 gt pas
Clipboard (] Font (] Alignment (] Mumber Fi Styles Cells Editing
I K15 - I | ¥
A B C D E F G H | J K L M N 8] P Q R S T U A W X
1 DETAILS OF STUDENT TUTION FEE INSTALMENT
2 5L STUDENT NAME | COURSE TOTAL TOTAL START MONTH TO END MONTH INSTALMENT OF THE COURSE TOTAL
3 | NO COURSEFEE| DUE JAN FEB MAR | APR | MAY | JUN JUL | AUG | SEP OCT | NOV | DEC
a4 1{SUSMITA SARKAR [DOAP 6000 400( 1000 400 300 400 600 400 300 400 400 0| 3S00f 3500 5600
5 2|AMAL SARKAR ADCA 6000 900 500 300 300 400 500 600 400 500 200 A00| 500 500 5100
i} 3|SUJAN SARKAR DOAP 6000 6000 1]
7 4|BIPUL SARKAR DCA 6000 6000 1]
8 5|SAMNGITA SAHA DOAP 6000 6000 1]
9 6{MAGNA DAS DPCTT 6000 6000 1]
10 T|AKASH ROY DTP 3300 3500 1]
11 8|SUMAN DAS DCTT 6000 6000 1] i
12 9|SUBIR MAHATO PGDCA 6000 6000 1] 1
13 10|JAYA ROY CCOAI 2800 2800 1]
14 1] 1]
15 1] 1]
16 0 0
17 1] 1]
13 1] 1]
19 1] 1]
20 1] 1]
21 Total= 54300 43600 1500 700 200 DO 1100 1000 o900 o00 600 400( 1000| 1000 10700
22
23
24
25
M 4 » M| Sheetl ~Sheet? - Sheet3 ¥ [ I

Ready

Hd |_(:ll)0% _3_— _E—;l.

s ™
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Home Insert Page Layout Formulas Data Review View Add-Ins @ - = 3
B . = = ) = ke O -
= ::E:; Calibri -1 A || [F = =] | SiwrepTet General - ijé #}ﬂ _‘D‘g == = I_E_—\ é::ltfwm ? [ﬁ
Pe g Fomat painter || B 4 U ~|[H ][O A~ [ F B[ & Eveescenter~ [§ - % o |5 ]| Conditional Fomat | Cel || nsert Delete Format | ) - Sotd Find&

Clipboard IF] Font IF] Alignment IF] Mumber F] Styles Cells Editing
I 116 v (> £ | |

A B C D E F G H | J K L |
1 STUDENT RESULT SHEET GRADATION WISE
2 SUBJECT

SLNO STUDENT NAME |BATCH NO

3 FUNDAMENTAL | MS-WORD | MS-EXCEL| MS-POWEN POINT | PRACTICLE | TOTAL | % OF MARK | GRADE
4 1|SUSMITA SARKAR ADO1 50 50 50 50 20 290 58 P
5 2 |AMIT GHOSH ADO2 80 67 67 80 80 374 74.8 C
6 3|NAYAN DAS A0D3 a0 80 87 89 87 433 86.6 B
7 4|PRITAM GHOSH ADO4 15 20 15 30 87 167 33.4 F
8 5(SHIULI SARKAR ADOS 25 50 25 45 89 234 46.8 F
9 6(SUMANTA DUTTA ADO6 a0 90 a7 a0 87 454 90.8 A
10 7|MANQOJ RABIDAS ADO7 36 18 15 25 79 173 34.6 F
11 8|SOPAN SARKAR ADOB 50 40 20 25 78 213 42.6 F
12 9|SUSMA ROY ADOS 78 78 89 89 86 420 84 B
13 10|{SANGITA PRAMANIK |AD10 30 25 50 26 92 223 44.6 F
14 NOTE : 89% Above= A Grade * 79% Above=B Grade * 69% Above C Grade * 49% Above P Grade * Other Fail
15
16 | _I
17
18 GRADE FORMULA >> | =IF(H4>89,"A",IF(H4>79,"B", IF(H4>69,"C",IF(H4>59,"D","F")))) |

14

M 4 » | Sheetl Sheet?2 - Sheetd %1 [ m . b
1 )

10:19 PM

4/12/2016
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A National Educational Programme of Computer Literacy & Development of Information Technology
S.C5.M Registered under the C.R. Act Ministry of HRD Govt. of India. & An ISO 9001 : 2008 Certified Organisation.

SI No Cntr Code Center Name DISTRIC Director Name MOBILE NO E-MAIL ID
1 WB-001 HARIRAMPUR SCSM D/DINAJPUR .
2 WB-002 RCTC CHANCHAL MALDA
3 WB-003 CHEKPOST BAIDARA SCSM U/ DINAJPUR
4 WB-004
5 WB-005 DANGRAM SCSM D/DINAJPUR
6 WB-006 HILI SCSM D/DINAJPUR
7 WB-007
8 WB-008
9 WB-009 FATEPUR SCSM U/ DINAJPUR
10 WB-010

Date : 15/04/2015

Signature of Director

MS-Excel 2007
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~

//Eaa=ae \
5.C.5.M

MARKSHEET / CERTIFICATE REQUISITION FORM

success Computer Saksharta Mission

A National Educational Programme of Computer Literacy & Development of Information Technology
An Autonomous Institution Registered Under the Public Trust Act, & Ministry of HRD Govt. of India.

NAME OF STUDY CENTER:

DIRECTOR NAME :

CENTRE ADDRESS: STUDY CENTRE CODE :
,\?L Regd. No Student Name Father's Name Course C:tt;:s;e Cs;u';ﬁe SI?: .et Certificate
1 WBO023/SEP16/D00109 JAN-15 DEC-16
2 JAN-15 DEC-16
3 JAN-15 DEC-16
4
5
6
7
8
9
10
11
12
13
14
15
16
Date : Signature of Director with Seal
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Receipt Payment Account for MGNREGS Fund for the year : 2013-2014
Harirampur Block, Dakshin Dinajpur

RECEIPT PAYMENT
. Materials ( Semi- .
1. Opening Balance as on 01/04/2014 Rs. 40557 Month Wage Skilled / Skilled Contingency Total
2. Total fund received during 2013-14 Rs. 1299849
13-Apr 69450 0 0 69450
13-May 110618 0 3200 | 113818
Memo No. Date District 13-Jun 95584 14741 0| 110325
4/10/2013 1900 13-Jul 0 0 0 0
29/01/14 700000 13-Aug 27814 0 0 27814
31/03/2014 576000 13-Sep 1083 0 0 1083
13-Oct 47659 0 0 47659
13-Nov 0 7038 0 7038
13-Dec 0 154445 0 154445
Total Fund Received during 2013-14 Rs. 1277900 14-Jan 217290 0 0 217290
Interest Received Rs.
21949 14-Feb 510370 0 0| 510370
Refund Amount from Scheme : NIL
0 13-Mar 0 0 0 0
Grand Total Rs. 1299849 Total 1079868 176224 3200 | 1259292
Prodhan
Joyhat G.P.
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